
Filière Conservation-restauration  

Bachelor of Arts HES-SO en Conservation 

 

 

 

 

 

 

Conception et réalisation de conditionnements pour 

deux crânes fossiles du musée Jurassica, permettant 

leur consultation sans manipulation directe 

 

Mémoire présenté par : 

Kakou Elvire 

 

Pour l’obtention du 

 

Bachelor of Arts HES-SO en Conservation 

Objets archéologiques et ethnographiques 

 

 

Année académique 2023-2024 

 

Remise du travail : 15.07.2024 

Jury : 27.08.2024 

Nombre de pages : 54 

  



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

 

 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

 

Engagement 

« J’atteste que ce travail est le résultat de ma propre création et qu’il n’a été présenté à aucun autre 

jury que ce soit en partie ou entièrement. J’atteste également que dans ce texte toute affirmation qui 

n’est pas le fruit de ma réflexion personnelle est attribuée à sa source et que tout passage recopié 

d’une autre source est en outre placé entre guillemets. » 

Date et signature :  

Neuchâtel, le 15 juillet 2024 

 

 

 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

1 

Remerciements 

J’adresse tout d’abord mes remerciements à l’ensemble des collaborateurs et collaboratrices de 

Jurassica, ainsi qu’à son directeur, M. Damien Becker, pour leur accueil chaleureux au sein de leur 

institution pendant toute la période de réalisation de ce travail et pour l’intérêt qu’ils ont manifesté 

pour mon projet. 

Parmi ces collaborateurs, je souhaite particulièrement remercier les quatre personnes suivantes. 

En premier lieu, je remercie M. Renaud Roch, préparateur restaurateur, mon maître de stage, pour 

son accompagnement bienveillant et sa disponibilité pour m’aider, répondre à mes questions et me 

conseiller. 

Je remercie également M. Olivier Maridet, conservateur du Museum, de m’avoir proposé ce sujet de 

travail passionnant. 

J’adresse également mes remerciements à M. Davit Vasilyan, responsable des services scientifiques, 

pour m’avoir transmis les informations au sujet du contexte entourant les deux spécimens concernés 

par mon travail et avoir répondu à toutes mes interrogations. 

Je remercie également M. Jérémy Anquetin, responsable recherche et formation, pour avoir pris le 

temps de m’enseigner l’utilisation du scanner 3D. 

Je souhaite ensuite remercier les cinq membres du Collège de Bachelor de la HE-Arc, M. Régis 

Bertholon, Mme Bluenn Boulangé, M. Thierry Jacot, Mme Janine Meier et M. Tobias Schenkel, pour 

leurs précieux conseils prodigués depuis le début de la phase de préparation de ce travail. 

J’adresse un remerciement particulier à M. Gaëtan Bussy, lab manager du FabLab de Neuchâtel, pour 

sa grande disponibilité, l’enthousiasme manifesté à l’égard de mon projet et le temps consacré à 

m’enseigner l’utilisation des outils de modélisation et d’usinage. 

Je souhaite également remercier tous mes proches qui m’ont soutenue et encouragée pendant ma 

formation et la réalisation de ce travail 

Je remercie tout particulièrement l’ensemble de la volée de Bachelor 2021-2024, dont la présence 

pendant ces trois ans a grandement contribué au plaisir de l’apprentissage. 

Et finalement, un grand merci à ma maman et à Loïc, pour la relecture, et pour leur soutien 

inestimable, en particulier lors de la dernière ligne droite. 

 

  



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

2 

Table des matières 

Remerciements......................................................................................................................... 1 

Résumé ................................................................................................................................... 4 

Abstract ................................................................................................................................... 5 

1 Introduction ..................................................................................................................... 6 

1.1 Mandat et objectifs .................................................................................................... 6 

1.2 Méthodologie ............................................................................................................ 6 

1.3 Conditionnements réversibles en paléontologie ............................................................. 7 

2 Présentation des objets...................................................................................................... 9 

2.1 Contexte .................................................................................................................. 9 

2.2 Description ..............................................................................................................10 

2.3 Valeurs culturelles ....................................................................................................11 

2.4 Matériaux ................................................................................................................11 

2.5 Traitements précédents.............................................................................................13 

2.6 Conditions de conservation ........................................................................................14 

3 Constats d’état, diagnostics et pronostic .............................................................................15 

3.1 Constat d’état de GRC-123 ........................................................................................15 

3.2 Diagnostic de GRC-123 .............................................................................................18 

3.3 Constat d’état de GRC-160 ........................................................................................18 

3.4 Diagnostic de GRC-160 .............................................................................................21 

3.5 Pronostic .................................................................................................................21 

4 Conditionnement ..............................................................................................................22 

4.1 Choix des matériaux .................................................................................................22 

4.1.1 Mousse................................................................................................................22 

4.1.2 Plastique cannelé..................................................................................................24 

4.1.3 Quincaillerie .........................................................................................................25 

4.2 Conception des conditionnements ..............................................................................25 

4.3 Réalisation des conditionnements ...............................................................................27 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

3 

4.3.1 Numérisation des objets ........................................................................................27 

4.3.2 Modélisation des supports .....................................................................................29 

4.3.3 Usinage des supports ............................................................................................32 

4.3.4 Construction de la boîte ........................................................................................34 

4.3.5 Assemblage et résultat final ...................................................................................36 

5 Conclusion ......................................................................................................................39 

6 Références bibliographiques ..............................................................................................41 

7 Crédits des images ...........................................................................................................45 

8 Liste des figures ...............................................................................................................46 

9 Liste des tableaux ............................................................................................................47 

10 Glossaire .........................................................................................................................48 

11 Annexes ..........................................................................................................................50 

11.1 Matériaux et fournisseurs ..........................................................................................50 

11.2 Procédure pour la modélisation des conditionnements en mousse dans Blender...............51 

 

 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

4 

Résumé  

Le musée Jurassica souhaite la réalisation de conditionnements pour deux fossiles : un crâne de 

crocodile et un crâne de castor. Leur forme plate et allongée, avec de petits os saillants, les rend 

sensibles aux altérations physiques s’ils ne sont pas conservés et manipulés de façon appropriée. De 

plus, ces spécimens présentent de nombreuses fissures et cassures qui les fragilisent, même si un 

traitement de consolidation les a stabilisés. 

Ces conditionnements doivent donc servir à la manipulation indirecte des spécimens et leur assurer un 

soutien permanent, tout en permettant la consultation de leurs deux faces. Un concept de 

conditionnement répondant à cette demande a été développé. Il consiste en une boîte en deux 

parties, contenant chacune un support en mousse découpé à la forme de l’objet qui est placé en son 

milieu. 

Le conditionnement peut être retourné sans que l’objet bouge à l’intérieur et peut être ouvert sur les 

deux faces, permettant la consultation de l’objet complet sans le sortir du conditionnement, et donc 

sans manipulation directe. Le logement des objets dans les supports en mousse assure une surface de 

contact maximale pour les soutenir, quelle que soit la face sur laquelle ils reposent. Des créneaux 

découpés dans la mousse permettent l’emboîtement précis des deux moitiés. 

Afin de réaliser ce concept, les objets ont été scannés en trois dimensions et les supports ont été 

modélisés par ordinateur. Ces modèles numériques ont été utilisés pour découper la mousse de 

polyéthylène à l’aide d’une fraiseuse CNC. Ces techniques ont permis la création d’empreintes très 

précises des objets dans leur conditionnement. 

Bien qu’un des conditionnements n’ait pas pu être terminé en raison de problèmes techniques, 

l’achèvement de l’autre conditionnement montre que le concept développé a permis de répondre aux 

objectifs liés aux besoins de conservation de ces deux fossiles. De plus, les techniques numériques ont 

permis d’obtenir une précision impossible à atteindre manuellement. 
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Abstract 

The Jurassica museum would like a conservation packaging to be made for two fossils: a crocodile 

skull and a beaver skull. Their flat and elongated shape, with little protruding bones makes them 

susceptible to physical alterations if they are not properly preserved and handled. Furthermore, these 

specimens have many cracks and fractures, which further weaken them, even if they have been 

stabilised by a consolidation treatment. 

This packaging should therefore be used for the indirect handling of these specimens and provide 

them with permanent support, while allowing for examination of both their sides. A packaging concept 

meeting these specifications was developed. It consists of a two-part box, each one containing a foam 

support cut to the shape of the object which is placed in the middle.  

The packaging can be turned upside down without the object moving inside and can be opened on 

both sides, allowing for the viewing of the whole object without removing it from the packaging and, 

therefore, without direct handling. The objects’ housing in the foam supports ensures a maximum 

contact surface to support them, whichever side they lie on. Crenelation shapes cut into the foam 

allow the two halves to fit together precisely. 

To implement this concept, the objects were scanned in three dimensions and the supports were 

digitally modelled. These digital models were used to mill the polyethylene foam using a CNC 

machine. These techniques made it possible very precise imprints of the objects in their packaging. 

Although one of the packagings could not be finished due to technical issues, the completion of the 

other one shows that the concept was able to meet the objectives determined by the conservation 

needs of these two fossils. Furthermore, the digital techniques made it possible to reach a level of 

precision that would be impossible to achieve by hand. 
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1 Introduction 

1.1 Mandat et objectifs 

Jurassica, institution muséale et de recherche consacrée aux sciences naturelles et située à Porrentruy 

(JU), possède une très large collection paléontologique. Au sein de cette collection, certains objets 

présentent des caractéristiques qui les rendent particulièrement fragiles et délicats à manipuler : faible 

épaisseur, fissures et cassures, petits éléments saillants. C’est le cas de deux crânes fossilisés 

provenant de la mine de Gračanica en Bosnie-Herzégovine, un crâne de crocodile et un crâne de 

castor, sur lesquels porte ce travail de Bachelor HES en conservation. 

Bien que ces deux fossiles soient stables, les risques d’altérations physiques en cas de mauvaise 

conservation ou manipulation sont élevés. La demande de l’institution est donc de fabriquer des 

conditionnements pour les deux spécimens, permettant de les conserver et de les manipuler de 

manière sûre, minimisant ainsi les risques d’altérations. Ces spécimens sont destinés à être conservés 

dans de nouveaux meubles du centre de recherche et de conservation des collections et à être étudiés 

dans le cadre de la recherche en paléontologie.  

L’objectif de ce travail de diplôme est donc la réalisation de boîtes de conditionnement pour les deux 

crânes fossiles, permettant la consultation des deux faces des spécimens sans manipulation directe. 

Pour que les boîtes de conditionnements remplissent pleinement leur mission, elles doivent 

correspondre aux critères suivants : 

 Assurer une surface de contact maximale avec les spécimens, pour leur garantir un soutien 

favorisant leur conservation à long terme ; 

 Une fois fermées, pouvoir être retournées sans que le spécimen bouge à l’intérieur, afin de 

pouvoir consulter ses deux faces ; 

 Pouvoir être refermées facilement sans créer de frottement sur le spécimen en essayant 

d’ajuster les parties supérieures et inférieures du conditionnement. 

Ce travail applique donc les méthodes de conservation préventive pour le développement de 

conditionnements répondant à ces demandes. 

1.2 Méthodologie  

La méthode suivie pour la réalisation de ce travail peut être synthétisée en neuf étapes. 

1. J’ai tout d’abord effectué une documentation des spécimens, afin d’avoir en ma possession 

des informations nécessaires pour guider mes choix. 

Cette documentation comprend : 

 L’identification des fossiles, de leurs matériaux et de leur valeur culturelle ; 
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 Leurs dimensions ; 

 Leur histoire matérielle, avec leur découverte, les traitements qui leur ont été 

appliqués et leur conditionnement actuel ; 

 Le constat d’état de ces objets, accompagné d’un diagnostic des altérations et d’un 

pronostic. 

2. Les techniques à utiliser pour la réalisation du conditionnement ont ensuite été choisies. Une 

partie avait déjà été décidée lors de la phase de préparation du travail (le module CW6 du 

Bachelor) et elles ont été affinées, notamment par des discussions avec M. Renaud Roch, mon 

maître de stage, préparateur restaurateur à Jurassica, et avec M. Gaëtan Bussy, lab manager 

du FabLab de Neuchâtel. 

3. Les matériaux à utiliser pour la fabrication du conditionnement ont également été choisis, en 

fonction de leurs propriétés physiques et de leur compatibilité avec les objets. 

4. J’ai numérisé les objets à Jurassica, à l’aide d’un scanner à lumière bleue structurée, afin d’en 

obtenir des modèles numériques en 3D. 

5. J’ai calculé les dimensions des différents éléments du conditionnement et dessiné des 

schémas et plans à suivre pour leur fabrication. 

6. À partir des modèles obtenus par numérisation, avec la collaboration de M. Bussy, j’ai utilisé 

un logiciel de modélisation 3D pour créer un modèle numérique des supports en mousse, 

contenant l’empreinte négative des objets. 

7. Afin d’être sûre des techniques choisies, j’ai effectué plusieurs tests : des tests de découpe de 

la mousse et la fabrication d’un petit prototype de boîte dans des chutes de carton cannelé. 

8. Les modèles 3D des supports en mousse ont été convertis en parcours d’outils pour une 

machine CNC, au FabLab de Neuchâtel, avec laquelle j’ai fraisé la forme de ces supports dans 

de la mousse de polyéthylène. 

9. J’ai construit les boîtes en polypropylène cannelé, puis assemblé les supports en mousse et les 

boîtes. 

1.3 Conditionnements réversibles en paléontologie 

Ce travail porte sur la réalisation d’un conditionnement qui peut être retourné afin de consulter les 

deux faces d’un spécimen. En paléontologie, des conditionnements sous forme de coques réversibles 

sont couramment utilisés. Ce type de conditionnement a été développé au Smithsonian Museum 

(Washington), notamment pour de grands spécimens1. Il s’agit de coques moulées à la forme de 

l’objet, faites de plâtre et de fibre de verre. Grâce au moulage, ces conditionnements assurent aux 

 

1 Chaney, 1995 ; Jabo et al., 2005 [en ligne]. 
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objets un soutien approprié, et qui ne se détériorera pas avec le temps en raison de la durabilité des 

matériaux. Ils permettent également de ne pas manipuler directement les spécimens, pour réduire les 

risques d’altérations, puisqu’on ne les sort pas de leur conditionnement. 

Cette technique de conditionnement est également utilisée à Jurassica (fig. 1). Elle présente toutefois 

deux inconvénients. Premièrement, les coques sont lourdes, car elles sont faites de plâtre, ce qui rend 

la manipulation difficile. Deuxièmement, au moment de refermer la coque, on risque d’abîmer les 

petites parties saillantes en tentant d’ajuster correctement les deux moitiés l’une sur l’autre. Le 

premier inconvénient a été contourné en fabriquant des coques en résine acrylique au lieu de plâtre 

(fig. 2), ce qui les rend plus légères. La question de réussir à la refermer sans problème d’ajustement 

se pose toujours, cependant. 

 

Figure 1 Coque réversible en plâtre 

 

Figure 2 Coque réversible en résine synthétique 

Selon le même principe, un conditionnement en 

bois et en mousse de polyéthylène (fig. 3) a été 

réalisé à Jurassica pour un fossile de 

Molassitherium (une espèce disparue de 

rhinocéros). Un lourd coffre en bois se justifie 

pour un objet lui-même lourd et de grande taille 

comme celui-ci. Cela ne conviendrait pas, 

toutefois, à des objets plus petits auxquels on 

ajouterait un poids superflu. De plus, pour des 

objets destinés à être conservés dans un meuble 

fermé, il vaut mieux éviter un matériau comme 

le bois qui peut dégager des acides organiques.  

C’est donc de ce type de conditionnements réversibles que je me suis inspirée, en cherchant à trouver 

la méthode la plus adaptée aux objets concernés. 

Figure 3 Boîte réversible en bois 
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2 Présentation des objets 

2.1 Contexte  

Les objets sur lesquels porte ce travail sont des 

fossiles provenant du site de Gračanica en 

Bosnie-Herzégovine (fig. 4). Ce site est une mine 

de charbon, en exploitation active depuis 19382. 

Les fossiles qui y ont été découverts sont des 

témoins de la faune et de la flore de cette région 

au début du Miocène* moyen (14,8 à 13,8 

millions d’années)3.  

Le site se situe dans le bassin* de Bugojno, 

appartenant à la série de bassins sédimentaires 

des Alpes dinariques*. Ceux-ci sont les témoins 

géologiques de paléoenvironnements* lacustres4. 

Les couches stratigraphiques* supérieures du 

site de Gračanica sont donc principalement 

composées de roches sédimentaires* issues de 

différents niveaux d’eaux lacustres, telles que la 

marne et le calcaire. Les couches inférieures, 

quant à elles, sont principalement composées de 

charbon* (lignite), issu d’un environnement de 

marais* et marécage*5 (fig. 5). C’est de ces 

couches inférieures que proviennent les deux 

spécimens concernés par ce travail.  

Le site a fait l’objet de plusieurs campagnes scientifiques au XXIe siècle et une équipe du Jurassica 

Museum s’y est rendue en 2017 et 20196. Puisque la mine de Gračanica est activement exploitée pour 

son lignite, des fossiles peuvent également y être découverts par les mineurs, ce qui est le cas des 

 

2 Göhlich et Mandic, 2020, p. 282. 

3 Göhlich et Mandic, 2020, p. 281. 

4 Göhlich et Mandic, 2020, p. 281. 

5 Göhlich et Mandic, 2020, p. 283-284. 

6 Göhlich et Mandic, 2020, p. 284. 

Figure 5 Vue orthographique de la mine de Gračanica 

Figure 4 Situation de la mine de Gračanica 

* Les mots suivis d’un astérisque sont définis dans le glossaire, p. 48-49. 
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deux fossiles en question ici. Le crâne de crocodile (GRC-123) a été trouvé en 2017 et le crâne de 

castor (GRC-160) a été trouvé en 2019.  

2.2 Description 

Le premier spécimen, dont le numéro d’inventaire est GRC-123, est un crâne fossilisé de crocodile, de 

l’espèce Diplocynodon ungeri (fig. 6 et 7). Ses os sont minéralisés (cf. chapitre 2.3) et compressés les 

uns sur les autres. Ses dents sont visibles en majorité sur une des faces, désignée dans ce travail 

comme « face A ». 

Ses dimensions maximales (hauteur x longueur x profondeur) sont de 3,5 x 38 x 13 cm. 

 

Figure 6 GRC-123, face A 

 

Figure 7 GRC-123, face B 

Le deuxième spécimen, dont le numéro d’inventaire est GRC-160, est un crâne fossilisé de castor 

(fig. 8 et 9). Il s’agit possiblement de l’espèce Steneofiber depereti, la même espèce à laquelle ont été 

attribuées cinq dents provenant du même site7. 

Le crâne est incomplet et séparé en deux parties : la plus grande partie est la partie supérieure du 

crâne avec ses dents, et la plus petite partie est un arc mandibulaire*. Pour la partie supérieure du 

crâne, la face avec les molaires et prémolaires visibles est désignée comme « face A » dans ce travail. 

Pour l’arc mandibulaire, la désignation des faces A et B ne s’est pas faite sur des critères anatomiques, 

mais le côté avec le moins de charbon visible a été désigné comme « face A ». 

Leurs dimensions maximales sont, respectivement, de 11,5 x 6,5 x 2,8 cm et de 7 x 3,5 x 1,1 cm. 

 

7 Stefen, 2020, p. 302. 
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Figure 8 GRC-160 (2 parties), faces A 

 

Figure 9 GRC-160 (2 parties), faces B 

À l’instar de l’autre spécimen, les os sont minéralisés et compressés.  

La raison pour laquelle ces crânes sont autant déformés, comparativement à des ossements 

d’animaux non fossilisés, est qu’ils ont été écrasés par le poids des sédiments au-dessus d’eux dans 

leur milieu d’enfouissement. 

2.3 Valeurs culturelles 

Ces deux spécimens appartiennent à une vaste collection d’objets de sciences naturelles, et en 

particulier d’objets paléontologiques, conservés à Jurassica. La raison de leur présence parmi eux est 

leur étude scientifique et leur valeur réside dans les informations qu’ils peuvent fournir à ceux ou 

celles qui les étudient, ce qui est appelé « valeur de recherche » dans le référentiel de Barbara 

Appelbaum8. 

2.4 Matériaux 

Ces deux objets sont principalement composés d’os et de dents fossilisés, c’est-à-dire qui ont subi des 

transformations après leur enfouissement ayant conduit à leur préservation dans le temps. 

L’os est un matériau organique avec une phase minérale. Plus précisément, il s’agit d’un tissu 

biologique dont les cellules sont englobées dans une matrice minéralisée9. La partie organique de la 

matrice de l’os est constituée de collagène, une protéine ; sa partie minérale est composée de cristaux 

 

8 Appelbaum, 2010, p. 102-104. 

9 « Bone », 2024 [en ligne]. 
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d’hydroxyapatite, un minéral de la famille des phosphates, dont la composition exacte varie selon 

chaque espèce, mais peut être représentée par la formule générale Ca10-X[(PO4)6-X(CO3)X](OH)2
10. 

Après la mort de l’animal, le collagène est dégradé par des processus chimiques et biologiques. Cette 

dégradation permet à l’eau présente dans l’environnement d’enfouissement de s’infiltrer à l’intérieur 

du tissu osseux11. Les éléments en solution dans l’eau sont alors responsables des changements qui 

conduisent à la préservation de l’os sous forme fossilisée (fig. 10). Au niveau moléculaire, des 

échanges d’ions ont lieu entre l’environnement et l’hydroxyapatite. Il est notamment fréquent que les 

hydroxydes (OH–) de l’hydroxyapatite soient substitués par des fluorures (F–) qui lui confèrent une 

plus grande stabilité12. La circulation d’eau dans les vides laissés par la dégradation du collagène 

permet aussi la précipitation de minéraux à l’intérieur de ces espaces vides. Ce processus est appelé 

perminéralisation13.  

À l’échelle macroscopique, un os est formé de deux couches. La couche extérieure, appelée os 

compact, est la plus dense, tandis que la couche intérieure, appelée os spongieux, est une structure 

poreuse14. Lors de la fossilisation, les pores de l’os peuvent aussi être remplis par des minéraux 

provenant de l’environnement15. 

 

Figure 10 Représentation schématique de la fossilisation de l’os. A) Structure macroscopique de l’os. B) 

Destruction du collagène ; l’hydroxyapatite est soit détruite également, soit préservée et transformée. C) 

Échanges ioniques entre l’hydroxyapatite et le milieu 

 

10 Keenan, 2021, p. 4. 

11 Keenan, 2021, p. 7. 

12 Keenan, 2021, p. 7. 

13 Keenan, 2021, p. 7. 

14 « Bone », 2024 [en ligne]. 

15 Keenan, 2021, p. 7. 
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Les dents ressemblent aux os dans leur composition. Elles sont principalement composées de dentine 

recouverte d’une couche d’émail. La composition de la dentine est proche de celle de l’os (collagène et 

hydroxyapatite). L’émail, quant à lui, est plus fortement minéralisé et composé essentiellement 

d’apatite de formule Ca10(PO4)6X2, où X peut représenter différents ions tels que le fluorure 

(fluoroapatite), l’hydroxyde (hydroxyapatite), le carbonate ou le bicarbonate16. Le processus de 

fossilisation est le même que pour l’os. 

Les os et dents fossilisés ne sont toutefois pas les uniques matériaux qui constituent ces deux objets. 

Ils sont également composés de charbon, la roche sédimentaire de leur milieu d’origine, encore 

présente à plusieurs endroits de la structure du fossile. De plus, suite aux traitements de préparation, 

des matériaux de consolidation et de collage sont également présents dans la structure des deux 

spécimens. 

2.5 Traitements précédents 

Sur site, les fossiles ont été prélevés avec le charbon autour d’eux et emballés dans du film 

cellophane. Ceci a pour but de préserver un taux d’humidité constant, car le charbon se rétracte en 

séchant, ce qui crée des tensions qui peuvent casser le fossile17. Ils ont ensuite été dégagés au 

laboratoire de préparation de Jurassica. 

Étant donné leur fragilité, ils ont été consolidés avant et après leur dégagement avec des résines 

synthétiques. Le crâne de crocodile a été initialement consolidé avec de la Mowilith® 30 (acétate de 

vinyle18) diluée à 10 % dans l’éthanol. Après son dégagement et une fois sec, il a été consolidé au 

Paraloid B72 (méthacrylate d’éthyle19) dilué à 10 % dans l’acétone. Le crâne de castor a été 

initialement consolidé avec du Paraloid B72 dilué à 10 % dans l’acétone. Après dégagement, il a été à 

nouveau consolidé avec la même solution20. 

Les deux spécimens ont également été recollés avec du Paraloid B72 dilué à 40 % dans l’acétone là 

où des cassures le demandaient. En particulier, le crâne de crocodile était cassé en deux parties dans 

le sens de la longueur et ces deux parties ont dû être recollées21. 

 

16 Shelton, 1994, p. 7. 

17 Roch, 2024. 

18 Résines synthétiques et dispersions, 2024 [en ligne], p. 3. 

19 Résines synthétiques et dispersions, 2024 [en ligne], p. 1. 

20 Roch, 2024. 

21 Roch, 2024. 
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2.6 Conditions de conservation  

Actuellement, le crâne de crocodile GRC-123 est conservé dans un bac en plastique rempli de graines 

d’orge perlé (fig. 11 et 12). Un grand sachet en polyéthylène est posé par-dessus pour le protéger de 

la poussière. Les grains d’orge constituent un bon support, car ils s’adaptent à la forme de l’objet sans 

exercer de contrainte sur lui. Ce conditionnement, qui n’a pas vocation à être permanent, présente 

tout de même des inconvénients. Premièrement, si des fragments se détachent, ils pourraient se 

perdre dans les grains et on pourrait même ne pas remarquer cette perte. Deuxièmement, comme 

l’objet présente des creux, des graines peuvent s’y glisser et y rester coincées. Troisièmement, la 

consultation complète de l’objet ne peut pas se faire sans le manipuler pour le retourner. 

 

Figure 11 GRC-123 dans son conditionnement 

 

Figure 12 GRC-123 dans son conditionnement (sans le 

sachet qui le recouvre) 

Le crâne de castor, quant à lui, est conservé dans un support en mousse de polyéthylène noire, 

contenu dans une boîte transparente fermée, probablement en polystyrène (fig. 13 et 14). Ce 

conditionnement traditionnel présente uniquement l’inconvénient de ne pas permettre la consultation 

de la face du dessous sans manipulation. Or, il n’est pas aisé de saisir l’objet dans ce but, car 

l’absence d’encoches pour les doigts oblige à le saisir par ses parties plus fines qui pointent hors de la 

mousse. 
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Figure 13 GRC-160 dans son conditionnement 

 

Figure 14 GRC-160 dans son conditionnement (couvercle 

ouvert) 

 

3 Constats d’état, diagnostics et pronostic 

3.1 Constat d’état de GRC-123 

Ce spécimen présente peu d’altérations de surface :  

 On constate une légère brillance superficielle.  

 Il présente, en deux endroits, des amas de résine synthétique.  

Ses principales altérations sont structurelles. On observe les phénomènes suivants : 

- Des fissures sont présentes sur l’ensemble de l’objet. Certaines sont très fines et donc très 

peu visibles. D’autres sont ouvertes jusqu’à 0,5 mm de largeur. 

- Plusieurs endroits présentent des cassures avec des lacunes de matière. Ces cassures suivent 

en grande partie les mêmes lignes que les fissures. 

- Certaines cassures qui ont engendré des lacunes sont plutôt sous forme de délamination : la 

couche supérieure du matériau s’est détachée et a disparu. 

De plus, des grains d’orge perlé se sont logés dans des cavités de l’objet. Ceux-ci ne restent pas 

forcément de manière permanente : parfois, ils se délogent d’eux-mêmes lorsque l’objet est manipulé. 

À l’exception des amas de résine, ces altérations sont généralisées sur l’ensemble de l’objet et il est 

impossible de les dénombrer. Les pages suivantes présentent donc des exemples représentatifs de 

chacune d’entre elles (tableau 1 et fig. 15). 
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Tableau 1 Illustration des différents types d’altérations sur le fossile GRC-123 

Altération Photographies représentatives Altération Photographies représentatives 

Surface 

brillante 

A  

Cassures et 

lacunes 

F  G  

Amas 

d’adhésif 

B  C   

Délaminations 

et lacunes 

H  I  

Fissures  

D  E  

Orge perlé 

dans les 

cavités 

J  K  
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Face A 

 

Face B 

 

Figure 15 Localisation des images du tableau des altérations de GRC-123 
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3.2 Diagnostic de GRC-123 

La brillance de la surface est due au traitement de consolidation avec une résine synthétique. Celle-ci 

est présente dans l’objet, mais aussi à la surface sous forme de film très mince, transparent et brillant. 

Les amas de résine synthétique, en revanche, sont certainement dus à des collages qui ont été faits 

plus tard. L’objet a dû se casser pendant la manipulation par des scientifiques étudiant le spécimen, 

qui ont ensuite recollé les fragments cassés. 

En dehors de ces cassures accidentelles, les fissures et une partie des cassures doivent plutôt être 

dues aux tensions subies par l’objet dans son milieu d’enfouissement, puis après son extraction. En 

effet, dans son milieu d’origine, il a subi le poids et le mouvement des roches et, après son extraction, 

il a subi des changements d’humidité relative. Le charbon qu’il contient étant plus hygroscopique que 

l’os, il gonfle et se rétracte à un taux différent de celui-ci. Cela cause donc des tensions, qui 

occasionnent les fissures, pouvant aller jusqu’à la cassure complète. Le matériau étant formé de 

plusieurs couches, ces tensions peuvent causer une délamination au lieu d’une cassure uniquement 

perpendiculaire.  

Quant à l’orge perlé, il sert de support au spécimen. Bien que les graines ne soient pas très petites 

(environ 4 mm de diamètre), quelques cavités sont suffisamment larges pour qu’elles s’y logent. Cela 

peut arriver lorsqu’on déplace le conditionnement ou qu’on retourne l’objet pour le consulter.  

3.3 Constat d’état de GRC-160 

La surface des deux parties de ce fossile présente une brillance un peu plus importante que celle du 

fossile GRC-123. Il s’agit de la seule altération de surface constatée. 

Du point de vue structurel : 

- Comme pour GRC-123, on observe de nombreuses fissures, parfois très fines et parfois plus 

ouvertes. Certaines traversent toute l’épaisseur de l’objet. La fissure la plus ouverte est une 

fissure traversante de 1 mm de largeur derrière les incisives. 

- Il y a également de petites cassures avec des lacunes de matière sur l’ensemble de l’objet. Un 

fragment de dent est détaché et se trouve à la surface de l’os de la mâchoire. 

Lors de la première ouverture de la boîte, un fragment dissocié de l’objet était simplement posé sur 

celui-ci. Il a été subséquemment mis de côté et n’est pas pris en compte dans ce travail. 

Ici aussi, les pages suivantes présentent des exemples représentatifs de chaque altération (tableau 2 

et fig. 16).  
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Tableau 2 Illustration des différents types d’altération sur le fossile GRC-160 

Altération Photographies représentatives 

Brillance 

A  G  

Fissures 

B  C  H  

Lacunes 

D  E  I  

Fragment 

dissocié 

F  
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 Face A Face B 

 

 Face A Face B 

 

Figure 16 Localisation des images du tableau des altérations de GRC-160 

  

A 

B / F 

C 

E 

D 

G 

H 
I 
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3.4 Diagnostic de GRC-160 

La brillance de la surface a la même cause que précédemment : il s’agit d’un film de résine 

synthétique utilisée pour la consolidation du fossile lors de sa préparation. 

De même, les fissures et les cassures sont dues aux tensions subies par l’objet dans son milieu 

d’enfouissement et après son extraction en raison du changement de milieu et donc de taux 

d’humidité dans son environnement. 

Le petit fragment de dent (tableau 3, image E) qui adhère à la surface de l’os, à côté de son 

emplacement d’origine, s’était certainement détaché avant la préparation du fossile et s’est retrouvé 

collé à cet endroit par la résine de consolidation. 

Quant au fragment dissocié (tableau 3, image F), il n’est pas certain qu’il appartienne aux parties du 

fossile concernées par ce travail. Il est peut-être sorti d’une des petites boîtes qui se trouvent dans la 

même boîte de conditionnement et qui contiennent d’autres fragments. C’est pourquoi il n’a pas été 

pris en compte ici. 

3.5 Pronostic 

Ces objets sont stables. Le traitement de consolidation qui leur a été appliqué leur permet de ne pas 

se fissurer ou se casser davantage. 

Toutefois, il est nécessaire qu’ils soient conservés dans des conditions climatiques stables. En effet, 

s’ils sont exposés à des variations d’humidité, il se produira des phénomènes de gonflement et 

rétraction du charbon. Ceux-ci conduiraient à des tensions dans l’os, moins hygroscopique et plus dur, 

et de nouvelles fissures ou cassures pourraient alors apparaître. 

Il est également important de les manipuler avec précaution. Grâce à la consolidation, ils sont 

suffisamment solides pour pouvoir être manipulés. Cependant, une manipulation sans précaution 

pourrait causer des chocs ou des tensions et casser des morceaux des objets, en particulier les dents 

et tous les petits os qui pointent hors de la masse principale. 

Préserver l’intégrité de ces objets permet de conserver les détails de leur anatomie afin qu’elle puisse 

être étudiée, préservant ainsi l’intégrité de leur valeur de recherche. 
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4 Conditionnement 

4.1 Choix des matériaux 

Le conditionnement réalisé pour les deux crânes fossilisés est constitué de deux matériaux principaux : 

un support en mousse et une boîte en plastique cannelé. En plus de cela, des rivets et des fermoirs 

métalliques ont été utilisés. 

4.1.1 Mousse 

La mousse de polyéthylène a été choisie pour réaliser les supports des objets. Il s’agit d’un matériau 

synthétique composé de polyéthylène expansé par la dispersion de bulles d’air dans sa masse22, 

formant de petites cellules délimitées par de fines couches de matière polymérique. 

Le polyéthylène est un bon matériau de conservation, inerte et stable. Son principal point faible est sa 

sensibilité aux rayons ultraviolets23, ce qui n’est pas un problème lorsqu’il est utilisé pour l’intérieur 

d’un conditionnement. 

L’expansion de la mousse est produite par des agents physiques (gaz ou liquides dissous dans le 

polymère) ou chimiques (composés solides produisant du gaz par réaction chimique)24. Les agents 

chimiques laissent des résidus dans la mousse qui pourraient altérer certains objets patrimoniaux, 

c’est pourquoi il est déconseillé d’utiliser des mousses expansées par agents chimiques en 

conservation25. 

Les mousses utilisées en conservation sont généralement blanches (sans pigmentation) ou noires. 

L’utilisation de mousses d’autres couleurs n’est pas recommandée, car les pigments utilisés peuvent 

affecter la stabilité du produit. Seule la stabilité des pigments noirs est certaine, car ceux-ci sont 

uniquement composés de carbone26. Les pigments noirs ont même un effet protecteur contre la 

photo-oxydation en absorbant les rayonnements UV27. 

Deux types de mousse ont été retenus et étudiés pour la réalisation de ce conditionnement : 

l’Ethafoam® et la Plastazote®. 

 

22 Tétreault, 2017, p. 49. 

23 Schlichting, 1994, p. 1. 

24 Williams, 2002, p. 27. 

25 Williams, 2002, p. 28. 

26 Schlichting, 1994, p. 1. 

27 Knotek et al., 2023, p. 2. 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

23 

Ethafoam® est une marque commerciale déposée de l’entreprise Sealed Air. Elle désigne une mousse 

de polyéthylène non réticulée* à cellules fermées*28, expansée par injection d’un hydrocarbure29. 

L’Ethafoam® 220, une mousse de 35 kg/m3 de densité, vendue sous forme de plaques de différentes 

épaisseurs, est couramment utilisée en conservation30. Ses cellules font environ 1-2 mm de 

diamètre31. L’inconvénient de cette mousse est qu’elle présente une surface légèrement abrasive 

lorsqu’on la découpe, à cause de l’ouverture des cellules. 

Plastazote® est une marque commerciale déposée de l’entreprise Zotefoams. Elle désigne une mousse 

de polyéthylène réticulée* à cellules fermées32, expansée par injection d’azote pur33. L’avantage de 

cette mousse est la petite taille de ses cellules (moins de 1 mm de diamètre), ce qui lui donne une 

surface lisse même après découpage. Elle coûte cependant plus cher que l’Ethafoam®. De plus, le 

procédé de réticulation de la mousse utilise des agents chimiques qui semblent être cause d’oxydation 

du polyéthylène dans le temps, avec dégagement d’acide acétique34. Malgré cela, elle est couramment 

utilisée et recommandée pour la conservation des objets patrimoniaux, en particulier dans sa version 

grise ou noire, plus stable35. On trouve cette mousse en différentes densités. Par exemple, l’entreprise 

Vibraplast la vend en densités de 29 kg/m3 (mousse LD29), 33 kg/m3 (LD33) et 45 kg/m3 (LD45). Ils 

ne vendent toutefois la mousse LD33 qu’en version colorée36.  

Le choix a été fait de réaliser un test d’usinage avec l’Ethafoam® 220 noire et la Plastazote® LD45 

noire. Cette dernière n’ayant pas été livrée au moment du test, une chute de Plastazote® de densité 

inconnue a été utilisée à la place. Les résultats du test ont été les suivants : le fraisage dans la 

mousse Plastazote® donne une découpe plus nette et plus visible (fig. 17), alors que la découpe dans 

l’Ethafoam® donne un résultat à l’apparence plus « floue » à cause de la plus grande taille des cellules 

(fig. 18). Cependant, la Plastazote® a davantage tendance à fondre et à laisser de la matière plastique 

sur la fraise (fig. 19), ce qui rend la découpe moins nette au fur et à mesure de son encrassement.  

 

28 « Ethafoam® », 2009 [en ligne]. 

29 Williams, 2002, p. 27. 

30 Tétreault, 2017, p. 50. 

31 Barber, 2014 [en ligne]. 

32 « Mousse Plastazote® », 2008 [en ligne]. 

33 TIS 01, 2024 [en ligne]. 

34 Knotek et al., 2023, p. 2 ; Curran et al., 2017, p. 6. 

35 Knotek et al., 2023, p. 17 ; Curran et al., 2017, p. 7. 

36 « Solutions de mousse plastique », 2024 [en ligne]. 
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Figure 17 Résultat du test d’usinage 

de la Plastazote® 

 

Figure 18 Résultat du test d’usinage 

de l’Ethafoam® 

 

Figure 19 Polyéthylène fondu autour 

de la fraise après le découpage d’un 

bloc de Plastazote® 

En fin de compte, c’est l’Ethafoam® 220 noire qui a été utilisée par défaut. En effet, la mousse 

Plastazote® LD45 noire commandée chez Vibraplast a rencontré un problème de livraison encore non 

élucidé à ce jour et n’a donc pas pu être utilisée. 

4.1.2 Plastique cannelé 

Le plastique cannelé, couramment aussi appelé « polypropylène cannelé », est un produit en plaques 

de copolymère de polypropylène et polyéthylène37, formées de deux couches séparées par des 

cannelures perpendiculaires. Grâce à ces cannelures, ce matériau est à la fois rigide et léger : les 

cannelures lui confèrent de la rigidité tout en diminuant la quantité de matière. Il s’agit du même 

principe que pour le carton cannelé, mais il est plus rigide que celui-ci38. Il lui a donc été préféré afin 

de convenir à la hauteur limitée de l’espace de rangement prévu (cf. chapitre 4.2) tout en bénéficiant 

d’une rigidité adéquate.  

Bien que les objets ne soient pas lourds, la longueur de la boîte nécessaire pour le crâne de crocodile 

nécessitait l’utilisation d’un matériau rigide. En effet, plus une plaque est grande, plus elle risque de 

ployer sous le poids de l’objet qu’elle soutient. C’est pour la même raison que des mousses 

relativement denses ont aussi été choisies. En effet, si le conditionnement plie sous le poids de son 

objet lorsqu’on le soulève (notamment pour le retourner), celui-ci n’est plus soutenu de manière 

uniforme sous toute sa surface et subit des tensions dues à la gravité. 

 

37 Schlichting, 1994, p. 1. 

38 Campbell, 1995, p. 188. 
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On trouve des plaques de polypropylène cannelé en différentes épaisseurs, la plus courante étant de 

4 mm39. C’est cette épaisseur qui a été choisie (plus précisément 3,8 mm), à nouveau pour trouver un 

bon compromis entre une épaisseur suffisamment faible et une rigidité suffisamment importante. 

4.1.3 Quincaillerie 

Pour la fixation des côtés de la boîte, des rivets aveugles en acier et aluminium ont été utilisés. Ceux-

ci permettent une fixation solide. Trois différents types de rivets ont été envisagés : les rivets en deux 

parties en polypropylène, les rivets en deux parties en métal ou les rivets aveugles en métal. Le choix 

des rivets aveugles s’est justifié par le fait qu’ils sont plus faciles à poser que des rivets métalliques en 

deux parties et qu’ils sont plus accessibles que les rivets en polypropylène : on les trouve à bon 

marché dans les magasins de bricolage. 

Des fermoirs en acier revêtu de laiton ont été sélectionnés pour la fermeture de la boîte. La principale 

difficulté était de trouver des fermoirs suffisamment petits pour être utilisés sur des boîtes mesurant 

moins de 6 cm de hauteur. Le modèle utilisé était le seul facilement accessible et correspondant à ce 

critère. 

De manière générale, les métaux peuvent être considérés comme des matériaux « idéals »40 en 

conservation. Cependant, il ne faut pas les mettre au contact direct des objets, car ils terniront avec le 

temps et peuvent les tacher41. Puisque ces éléments de quincaillerie ne seront pas en contact avec les 

fossiles, il n’y a pas eu d’hésitation à les utiliser. 

4.2 Conception des conditionnements 

Pour rappel, les critères du conditionnement attendu sont les suivants : 

 Assurer une surface de contact maximale avec les spécimens ; 

 Pouvoir être ouvert sur les deux faces, afin de consulter le recto et le verso des spécimens 

(face A et face B) ; 

 Pouvoir être refermé facilement sans créer de frottement sur le spécimen en essayant 

d’ajuster les deux parties. 

 Une fois fermé, pouvoir être retourné sans que le spécimen bouge à l’intérieur ; 

Plusieurs décisions ont été prises pour atteindre ce résultat. 

 

39 Schlichting, 1994, p. 6. 

40 Tétreault, 2017, p. 10. 

41 Tétreault, 2017, p. 10. 
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Premièrement, pour qu’il y ait une surface de contact maximale entre les objets et leur support, les 

objets ont été numérisés sous forme de modèle 3D afin de pouvoir fraiser dans de la mousse, à l’aide 

d’une machine à commande numérique (CNC), leurs empreintes négatives les plus exactes possibles. 

L’idée d’utiliser cette méthode a été confortée par la lecture d’une publication présentant une 

méthodologie similaire42. 

Deuxièmement, le conditionnement a été conçu comme un assemblage de deux moitiés identiques, 

qui ont la forme de « boîtes à chaussures » sans couvercle. De cette façon, il peut être retourné et 

posé sur n’importe laquelle de ces deux parties pour consulter la face A ou B de l’objet. 

Troisièmement, pour pouvoir refermer le conditionnement de manière toujours exacte, un relief de 

créneaux a été découpé dans la mousse. Ce relief sert de guide : il n’y a qu’une seule façon de fermer 

la boîte et la forme du relief empêche tout mouvement pendant la descente d’une moitié sur l’autre. 

Une forme avec des angles droits a été choisie pour empêcher tout mouvement latéral. 

Finalement, un fermoir métallique a été utilisé pour assurer une fermeture sécurisée, afin que les deux 

moitiés du conditionnement ne puissent pas s’écarter l’une de l’autre lorsqu’on retourne la boîte. En 

effet, si les deux moitiés ne sont pas solidement attachées l’une à l’autre et qu’elles s’écartent lors du 

retournement, l’objet à l’intérieur peut bouger et subir des altérations physiques. 

En plus de ces éléments, la hauteur du conditionnement terminé a été prise en compte. En effet, ces 

spécimens devraient idéalement être conservés dans de nouveaux meubles (après le déménagement 

des collections) dont les tiroirs font 6 cm de hauteur. Cet aspect a donc ajouté une nouvelle contrainte 

au mandat initial, mais qui restait un idéal à atteindre, et non une obligation. Une hauteur de 5 cm a 

donc été tentée, mais n’a pas pu être réalisée : une hauteur de 5,8 cm a finalement été arrêtée. 

Les dimensions du conditionnement ont été calculées de la manière suivante. Premièrement, la 

largeur et la longueur des supports en mousse ont été calculées en fonction de la dimension des 

objets en y ajoutant une marge de 1 cm et une marge supplémentaire de 0,5 cm pour découper une 

fente servant à enfoncer les bords d’une interface en intissé synthétique. À cela ont été ajoutés 2 cm 

dans les deux dimensions pour les créneaux. Pour le spécimen GRC-160, qui est constitué de deux 

parties, le calcul a été fait en utilisant la longueur de la plus grande partie et la largeur des deux 

parties, en ajoutant une marge de 1 cm entre les deux. 

Cela donne des dimensions de supports de 20 x 45 cm pour le crâne de crocodile (GRC-123) et de 

18,5 x 19 cm pour le crâne de castor (GRC-160). Quant à l’épaisseur, il a été prévu d’utiliser des 

mousses de 3 cm. 

 

42 Stache et al., 2014 [en ligne]. 
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Le concept de conditionnement correspondait donc à ce schéma : 

 

Figure 20 Schéma en coupe du concept de conditionnement 

4.3 Réalisation des conditionnements 

4.3.1 Numérisation des objets 

Les objets ont été numérisés avec un scanner Artec Space Spider. Il s’agit d’un scanner 3D à lumière 

bleue structurée, dont la précision* est de 0,05 mm et la résolution* de 0,1 mm, avec une capture de 

7,5 images par seconde43. Ce scanner est utilisé à Jurassica pour la numérisation des collections. 

Un scanner à lumière structurée projette sur 

l’objet un motif précis de lumière (dans ce cas-ci, 

de la lumière bleue). Lorsqu’il atteint la surface de 

l’objet, ce motif est déformé par le relief et la 

forme de cette surface (bosses, creux, etc.). 

(fig. 21) Le scanner capture alors les images du 

motif déformé et son logiciel transforme ces 

données visuelles en données de modélisation 3D. 

Certains scanners 3D, comme l’Artec Space 

Spider, numérisent également la texture de 

 

43 Space Spider, 2023 [en ligne], p. 2. 

    

 
  
 

 
  
 

 
  

 

 
  

  
 

          
         

        
        

     

Figure 21 Principe de la lumière structurée : la lumière 

émise par le scanner passe à travers une grille pour 

projeter un motif sur l’objet. 
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l’objet, c’est-à-dire ses couleurs et d’autres caractéristiques de surface qui peuvent être capturées par 

la photographie44. 

Pour numériser les objets, ceux-ci ont été posés sur 

une plaque tournante. Cela permet de capturer des 

images tout autour de l’objet sans le manipuler, 

avec un mouvement assez fluide et en gardant le 

scanner à une distance constante (fig. 22). En effet, 

pour qu’il puisse capturer correctement l’objet, il 

faut le maintenir à une distance entre 17 et 30 cm 

(mais idéalement entre 20 et 27 cm), qui 

correspond à sa profondeur de champ, et scanner 

avec des mouvements fluides. Si l’objet sort de sa 

profondeur de champ ou si les déplacements sont trop brusques, le scanner perd le suivi de l’objet. 

Pour chacun des objets, 6 prises de vues ont été faites (recto, verso, et 4 tranches) et combinées 

dans le logiciel Artec Studio 17 Professional pour créer le modèle 3D final. Pour capturer les tranches, 

les objets ont été maintenus en position verticale avec des supports en mousse PE et en éponge 

synthétique. Le logiciel permet, après la numérisation, de supprimer les données inutiles, en 

particulier la plaque tournante et les supports en mousse. Ensuite, on aligne les différentes prises de 

vue et on les fusionne. L’algorithme du logiciel lui permet de faire cet alignement de façon très fine. 

Les prises de vues qui n’ont pas pu être bien alignées, ou avec une erreur trop élevée, peuvent être 

supprimées du résultat final.  

Le résultat de ce traitement de données est un modèle 3D sous forme de mesh (fig. 23), c’est-à-dire 

la représentation de l’objet, dans un système à trois coordonnées (x, y, z), sous forme d’une surface 

externe composée d’un ensemble de polygones. Sur ce mesh est également appliquée la texture qui a 

été capturée par le scanner en même temps que la forme (fig. 24).  

 

44 McMillion, 2022 [en ligne]. 

Figure 22 Numérisation du fossile GRC-160 



HE-Arc CR, Bachelor of Arts HES-SO en Conservation 

Kakou Elvire, Conception et réalisation de conditionnements pour deux crânes fossiles, 15.07.2024 

29 

 

Figure 23 Aperçu du mesh finalisé de GRC-123 dans le 

logiciel Artec Studio 

 

Figure 24 Aperçu du mesh finalisé de GRC-123 avec sa 

texture dans le logiciel Artec Studio 

Les surfaces brillantes peuvent causer des difficultés pour capturer correctement les données. On 

craignait donc que la brillance de certaines surfaces ne pose problème. Il s’est finalement avéré que le 

scanner a très bien réussi à numériser ces zones, probablement entre autres grâce à la capture sous 

différents angles. Le seul défaut dans le résultat est quelques zones dont la couleur n’est pas rendue 

de manière très fidèle, mais cela ne pose pas de problème pour le projet de conditionnement. 

Pour pouvoir réaliser cette numérisation, il m’a d’abord fallu apprendre à utiliser le scanner et le 

logiciel, qui m’ont été présentés par M. Jérémy Anquetin, responsable de la recherche et de la 

formation à Jurassica. Le scanner est facile d’utilisation, mais nécessite de se familiariser avec les 

mouvements. La numérisation des tranches, qui est plus délicate que les faces en raison de leur plus 

petite surface, m’a demandé plusieurs tentatives pour que le scanner ne perde pas le suivi de l’objet. 

Pour la prise en main du logiciel, j’ai suivi le protocole écrit utilisé habituellement dans l’institution.  

4.3.2 Modélisation des supports 

Après la numérisation des objets, leurs futurs supports en mousse ont été modélisés numériquement. 

Cela a été réalisé dans le logiciel Blender, un logiciel libre* de modélisation numérique en 3D. Les 

meshes des objets numérisés y ont été importés afin de créer leur empreinte négative dans un autre 

mesh représentant le bloc de mousse qui doit les recevoir. 

Plusieurs aspects du conditionnement des objets ont dû être pris en compte pour modéliser des 

supports appropriés. 

Premièrement, le scanner a capturé le relief exact de l’objet selon tous les angles de vue. Par 

conséquent, si on reproduisait l’empreinte de ce relief telle quelle dans de la mousse, des contre-

dépouilles empêcheraient de placer correctement l’objet dans son support. La solution trouvée à ce 
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problème a été de réaliser une heightmap de chaque face de l’objet, prise selon une vue 

orthographique (donc sans perspective)45. Une heightmap est une image, généralement en nuances 

de gris, dont les couleurs représentent un déplacement par rapport à une surface de référence : le 

blanc représente l’éloignement maximal de cette surface et le noir, l’éloignement minimal.  

Le modèle de l’objet a donc d’abord été positionné dans l’environnement numérique exactement de la 

façon dont il devra être positionné dans son conditionnement réel. Étant donné que le 

conditionnement prévu comporte deux moitiés englobant l’objet, le niveau 0 (zéro) de 

l’environnement numérique selon les axes x et y représente la séparation entre ces deux moitiés 

(fig. 25 et 26). 

 

Figure 25 Positionnement de GRC-123 selon les 3 axes 

dans Blender 

 

Figure 26 Positionnement de GRC-160 (partie 1) selon 

les 3 axes dans Blender 

Ensuite, une texture a été ajoutée à ce modèle numérique, programmée de façon à ce que les points 

au niveau 0 soient noirs et que les points les plus 

élevés de l’objet soient blancs, avec les différentes 

nuances de gris entre les deux. 

Finalement, une caméra virtuelle a été placée au-

dessus de l’objet, et une image orthographique a 

été capturée par cette caméra (fig. 27). Le même 

processus a été répété pour l’autre face de l’objet, 

en le retournant autour de l’axe y.  

À partir de cette heightmap, le logement pour accueillir l’objet dans la mousse a été modélisé en 

déplaçant les points d’un plan en fonction des données de hauteur représentées par les différentes 

nuances de gris de l’image. C’est ce plan déformé qui a été utilisé pour « creuser » dans le bloc de 

 

45 Risingfall, 2018 [en ligne]. 

Figure 27 Exemple de heightmap : face B de GRC-

123 
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mousse virtuel. Cette dernière étape consiste à placer le plan au bon endroit sur la forme représentant 

le bloc de mousse et à réaliser une opération de soustraction.  

Il est donc essentiel, dans tout ce processus, de réfléchir correctement dès le départ au 

positionnement de l’objet dans son conditionnement. En effet, si on change d’avis sur le 

positionnement de l’objet, tout le processus doit être recommencé. 

Le deuxième aspect qu’il a fallu particulièrement prendre en compte est la taille du logement pour 

l’objet. En effet, en créant une empreinte exactement aux mêmes dimensions que l’objet lui-même, il 

aurait manqué une marge pour pouvoir glisser l’objet dans son logement. Pour cela les deux modèles 

ont été « gonflés » de 0,4 mm dans toutes les directions avant même de créer la heightmap, pour que 

leur empreinte soit plus grande qu’eux-mêmes. 

C’est aussi dans Blender qu’ont été modélisés les « créneaux » permettant l’imbrication des deux 

moitiés de support, en ajoutant de petits pavés au mesh d’un bloc de mousse (et leur empreinte 

négative dans l’autre) (fig. 28). Ces petites formes ont été créées avec des angles arrondis en 

prévision de leur usinage. En effet, la fraise n’aurait pas pu créer les négatifs des créneaux avec des 

angles droits. Des angles arrondis, en positif et en négatif, ont donc été prévus directement dans le 

modèle. 

 

Figure 28 Modèle de la mousse pour la face B de GRC-

160 dans l’environnement 3D de Blender 

 

Figure 29 Modèle de la mousse pour la face A de GRC-

160 dans l’environnement 3D de Blender 

Le travail de modélisation a nécessité que je me familiarise d’abord avec le logiciel Blender, qui est 

complexe et demande donc un apprentissage assez long lorsqu’on n’a jamais pratiqué la modélisation 

3D. J’ai bénéficié pour cela de la collaboration de M. Gaëtan Bussy du FabLab de Neuchâtel et des 

nombreuses ressources en ligne concernant ce logiciel. Blender est un logiciel très complet et 

puissant, qui offre de nombreuses possibilités. À chaque fois que j’ai voulu résoudre une question 

spécifique, j’ai trouvé l’option pour le faire. En outre, une fois que j’ai eu maîtrisé les notions de base 

et que le processus voulu pour ce travail a été entièrement développé, la réalisation de celui-ci à 
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plusieurs reprises pour créer les quatre modèles était aisée et ne prenait que quelques minutes à 

chaque fois. 

4.3.3 Usinage des supports 

Après leur modélisation, chaque moitié de support a été exportée au format .stl*. Puis, les parcours 

d’usinage de la fraiseuse ont été programmés à partir de ces modèles dans le logiciel VCarve de 

l’entreprise Vectric. Ce logiciel permet de générer des fichiers au format .ncp*, lus par le logiciel qui 

contrôle la CNC. La machine utilisée, une Makko 850, se trouve au FabLab de Neuchâtel, qui détient 

également une licence pour le logiciel VCarve. 

Une machine CNC est une machine-outil contrôlée par un code qui contient une liste de 

coordonnées46. Dans ce cas, il s’agit plus précisément d’une fraiseuse CNC qui a été utilisée. Elle 

possède donc une broche qui fait tourner une fraise et qui se déplace selon trois axes. La pièce à 

usiner est maintenue immobile et la fraise découpe le matériau en se déplaçant, le réduisant en 

copeaux. 

Pour découper ces mousses, plusieurs fraises ont été utilisées successivement, afin d’arriver à un 

résultat net. D’abord, un parcours d’ébauche a été effectué avec une fraise de 3 mm de diamètre pour 

les mousses ayant moins de matière à retirer (fig. 30), ou 5,5 mm de diamètre pour les mousses 

ayant plus de matière à retirer. Ensuite, deux parcours de finition ont été réalisés : le premier avec 

une fraise de 3 mm de diamètre et le deuxième avec une fraise de 1 mm de diamètre (fig. 31).  

 

Figure 30 Ébauche d’un support avec une fraise de 

3 mm de diamètre 

 

Figure 31 Finition d’un support avec une fraise de 1 mm 

de diamètre 

L’ébauche permet d’enlever plus rapidement une plus grande quantité de matière, alors que la finition 

permet d’obtenir la précision voulue et des surfaces plus nettes et esthétiques. Deux parcours 

 

46 « Le guide ultime de l’usinage CNC », 2023 [en ligne]. 
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différents de finition ont été programmés, car la fraise de 3 mm était suffisante pour la finition des 

créneaux alors que la finition des logements pour les objets nécessitait l’usage de la fraise de 1 mm, 

dont le travail prend plus de temps. 

À cause du degré de précision, l’usinage de chaque support en mousse a nécessité plusieurs heures : 

environ trois heures pour les plus petites mousses et six heures pour les plus grandes. Après 

l’usinage, quelques petits copeaux restaient accrochés à la mousse. Ceux-ci ont été enlevés à la main 

et au cutter afin d’obtenir un résultat propre et net. 

Plusieurs problèmes techniques inattendus ont été rencontrés lors de l’usinage. Premièrement, 

l’usinage de la mousse pour la face B de GRC-160 ne s’est pas fait exactement selon le modèle lors du 

passage avec la fraise de 3 mm : la finition des créneaux les a réduits à une largeur plus petite que 

prévu et la surface plane a été usinée plus bas que prévu à partir de la moitié (fig. 32). Cela ne pose 

heureusement pas de problème pour la fonctionnalité du support (les emplacements pour les objets 

ne sont pas décalés et les créneaux s’emboîtent quand même très bien), mais l’aspect de propreté de 

la finition est affecté.  

Ensuite, lors de l’usinage de la mousse pour la face A de GRC-123, un problème similaire est arrivé, 

également à partir du milieu du passage de la fraise de 3 mm. Cette fois-ci, le support a été rendu 

inutilisable, car la mousse a été traversée de part en part à plusieurs endroits avant que le problème 

ne soit remarqué (fig. 33). L’usinage de ce support a donc été recommencé. Cependant, après le 

premier passage d’ébauche avec la fraise de 5,5 mm, le moteur qui contrôle la rotation des fraises 

s’est arrêté et n’a plus redémarré. Par conséquent, ce support n’a pas pu être terminé (fig. 34). 

 

Figure 32 Support pour la face B de 

GRC-160 avec erreur d’usinage 

 

Figure 33 Support détruit après 

dysfonctionnement de la CNC 

 

Figure 34 Support non terminé suite 

à l’arrêt de la machine 

Outre ce dysfonctionnement imprévisible, le principal désagrément rencontré lors de cette étape a été 

le temps nécessaire à sa réalisation. Il devrait toutefois être possible de réduire ce temps avec plus 

d’expérience. En effet, la licence du logiciel VCarve vient d’être acquise par le FabLab de Neuchâtel et 

ce travail a donc constitué un test de son utilisation. Il a d’ailleurs fallu attendre que le logiciel soit 

prêt avant de pouvoir faire les premiers tests d’usinage. Pour gagner du temps, il devrait être possible 

de programmer les parcours d’outils pour qu’ils ne passent pas dans le vide sur des surfaces qui n’ont 
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pas besoin d’être découpées, mais se dirigent directement dans les zones délimitées par le modèle 3D 

importé. Nous n’avons cependant pas trouvé cette option dans le logiciel. Entre les délais liés au 

logiciel et les défaillances de la machine, l’usinage CNC a été l’obstacle principal dans ce travail, 

malgré la grande commodité de cette technique. 

4.3.4 Construction de la boîte 

La partie extérieure du conditionnement est une boîte formée de deux moitiés presque identiques, en 

plastique cannelé. 

Le modèle qui a servi à la conception de cette boîte est la forme « boîte à chaussures », apprise lors 

du cours de conditionnement AW3.2 du Bachelor en conservation47. Ce modèle est habituellement 

composé d’une boîte et d’un couvercle, mais, ici, le couvercle a été remplacé par une deuxième boîte 

qui se superpose à l’autre. 

Chaque boîte a été construite selon le plan suivant : 

 

Figure 35 Plan pour la fabrication des boîtes 

 

47 Boulangé, 2022, p. 6. 
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Pour que la boîte puisse être correctement formée, il faut tenir compte de l’épaisseur de la feuille de 

plastique cannelé, ici 4 mm. C’est pourquoi 4 mm sont ajoutés à la hauteur en prenant en compte 

l’épaisseur du fond et 2 mm sont ajoutés pour chaque pli, c’est-à-dire une demi-épaisseur. De plus, 

4 mm sont ajoutés à la largeur avant le pli des rabats, pour tenir compte de l’épaisseur des côtés 

attenants. 

Pour chaque conditionnement ont été donc construites deux boîtes, l’une d’une hauteur de 2 cm et 

l’autre d’une hauteur de 3 cm. En effet, les deux mousses de 3 cm ont été creusées pour s’emboîter 

sur une hauteur de 1 cm, afin d’arriver à une hauteur totale intérieure de 5 cm. 

Les dimensions utilisées pour chaque boîte sont donc : 

Tableau 3 Dimensions pour la construction des boîtes 

Objet  h L l 

GRC-160 
2 cm 19 cm 18,5 cm 

3 cm 19 cm 18,5 cm 

GRC-123 

2 cm 45 cm 20 cm 

3 cm 45 cm 20 cm  

Le polypropylène cannelé a été découpé selon le 

plan à l’aide d’un cutter et d’une règle à découper 

en métal. Ensuite, les rebords ont été pliés. Pour 

cela, les plis ont d’abord été marqués avec un plioir. 

Puis, l’emplacement à plier a été chauffé à l’aide 

d’un décapeur thermique. Enfin, ils ont été pliés le 

long d’une règle métallique avant refroidissement. 

Le polypropylène étant un polymère 

thermoplastique, la chaleur permet de le ramollir 

pour le façonner plus facilement48 (fig. 36). 

Les boîtes ont ensuite été rivetées. Après leur 

assemblage, les bords n’étaient pas parfaitement droits, mais s’écartaient en direction de l’extérieur à 

cause de la tension dans les plis (fig. 37). Ceux-ci ont donc été à nouveau chauffés à l’aide du 

décapeur thermique et redressés à la main pour qu’ils soient perpendiculaires au fond (fig. 38). 

 

48 Schlichting, 1994, p. 3 ; Tétreault, 2017, p. 47. 

Figure 36 Boîte de 3 cm pour GRC-160 découpée et 

pliée 
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Figure 37 Boîte avant redressement des bords 

 

Figure 38 Boîte après redressement des bords 

En dernier lieu, les fermoirs ont été fixés à la boîte avec leurs vis. Les extrémités des vis dépassant 

légèrement ont été coupées à la pince coupante pour éviter les blessures. 

4.3.5 Assemblage et résultat final 

Après la fabrication des supports en mousse et des boîtes en polypropylène cannelé, l’ensemble du 

conditionnement a été assemblé afin d’y placer les objets. 

Tout d’abord, les supports en mousse ayant été 

intentionnellement usinés dans des blocs plus grands 

que leurs dimensions finales, ceux-ci ont été découpés 

à la bonne taille. Une découpeuse à fil chaud a été 

utilisée pour cette tâche. Celle-ci tranche dans la 

mousse en la faisant fondre au contact d’un fil 

métallique tendu chauffé (fig. 39). 

Les deux moitiés du support ont été découpées 

ensemble, emboîtées l’une dans l’autre, afin d’obtenir 

la même découpe sur les deux. 

Il était prévu de placer une interface en intissé synthétique entre la mousse et les objets. Cependant, 

après avoir testé cela avec la plus grande partie du crâne de castor, cet aspect a été abandonné. 

L’interface avait pour but d’éliminer le côté légèrement abrasif de la mousse découpée. Deux intissés 

différents ont été essayés : du Bondina® (intissé de polyester49) et du Tyvek® (intissé de 

 

49 Jacot, 2022, p. 7. 

Figure 39 Découpage au fil chaud 
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polyéthylène50). Cependant, la surface lisse de l’intissé permettait au fossile de glisser et de se déloger 

de son empreinte. Le risque encouru aurait alors été que, lors de sa consultation, il soit légèrement 

décalé et subisse la pression d’une empreinte mal ajustée après fermeture de la boîte. Il a donc été 

jugé que l’objet était plus en sécurité sans interface. Il est à noter que la majorité des ossements 

fossiles conservés dans de la mousse Ethafoam® à Jurassica le sont sans interface et que l’usage a 

montré que cela ne leur causait pas de dommage. 

Après le placement des mousses dans les boîtes et un essai de fermeture et ouverture, un aspect non 

anticipé a été constaté : les deux mousses sont restées emboîtées l’une dans l’autre grâce à leurs 

créneaux au lieu de rester chacune dans sa boîte. Pour pallier cela, les mousses ont été collées au 

fond des boîtes avec de la colle thermofusible appliquée au pistolet à colle. Ce type de colle peut être 

composée de différentes résines thermoplastiques et permet d’éviter un long temps de séchage51 lors 

d’assemblage de conditionnements. L’adhérence de la mousse au polypropylène cannelé grâce à la 

colle a été suffisante pour contrer l’adhérence mécanique des mousses entre elles. 

À la page suivante, les figures 40 à 43 présentent le conditionnement terminé de GRC-160. 

Pour ce qui est du spécimen GRC-123, son conditionnement n’a pas pu être terminé en raison de 

l’absence d’un des deux supports en mousse (cf. chapitre 4.3.3). Le spécimen a cependant déjà été 

placé dans la moitié de conditionnement existante, car il y bénéficie déjà d’un meilleur soutien que 

dans son conditionnement temporaire précédent. Le résultat à ce jour est présenté dans les figures 44 

et 45. 

 

50 Tétreault, 2017, p. 55. 

51 Tétreault, 2017, p. 30. 
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Figure 40 Conditionnement de GRC-160 fermé 

 

Figure 41 Conditionnement de GRC-160 fermé (vue de 

dessus) 

 

Figure 42 Conditionnement de GRC-160 ouvert, face A 

visible 

 

Figure 43 Conditionnement de GRC-160 ouvert, face B 

visible 

 

Figure 44 GRC-123 dans la moitié de conditionnement 

terminée 

 

Figure 45 Éléments terminés du conditionnement de 

GRC-123 
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5 Conclusion 

Ce mémoire de Bachelor a porté sur la réalisation de conditionnements pour deux fossiles fragiles 

conservés au Jurassica Museum, afin de permettre leur consultation sur deux faces sans manipulation 

directe. J’ai appliqué une méthodologie de conservation préventive pour développer un concept de 

conditionnement et j’ai fait appel à des moyens technologiques pour sa réalisation. 

À la fin de ce travail, l’objectif n’est pas entièrement atteint. En effet, un seul conditionnement a pu 

être terminé au lieu de deux. Toutefois, le conditionnement qui a été achevé remplit les conditions 

demandées dans le mandat. 

L’usinage CNC d’après modèle 3D a permis d’obtenir des supports pour les objets avec une surface de 

contact maximale. Les objets ne subissent ni pression ni tension à l’intérieur de leur conditionnement. 

Celui-ci peut également être retourné sans risque : tant que le conditionnement est fermé, l’objet ne 

bouge pas à l’intérieur. Finalement, la géométrie crénelée des supports permet de refermer le 

conditionnement d’une seule façon, avec un mouvement vertical évitant les frottements latéraux qui 

pourraient accrocher des parties fragiles de l’objet. 

Les techniques numériques utilisées pour ce projet présentent de nombreux avantages et permettent 

de réaliser facilement des travaux d’une grande précision avec, toutefois, la nécessité d’apprendre à 

utiliser plusieurs nouveaux outils. Un inconvénient notable est leur coût : à l’exception de Blender, qui 

est un logiciel libre et gratuit, les appareils utilisés et les licences de logiciels représentent un 

investissement important. Dans le cadre de ce travail, la collaboration avec le FabLab de Neuchâtel et 

le fait que l’institution possédait déjà un scanner ont permis de contourner cet aspect. 

Malgré le fait que les objets à conditionner n’étaient pas de grande taille, le temps passé pour 

l’usinage de la mousse a été considérable. Cela remet en question l’efficacité de cette méthode si elle 

devait être utilisée pour réaliser de nombreux conditionnements. D’autres études seraient nécessaires 

pour évaluer la possibilité de réduire ce temps, en variant différents aspects de la programmation ou 

des outils utilisés. 

Je pense, malgré cela, que les techniques numériques utilisées dans le cadre de ce travail sont très 

prometteuses. En effet, elles ont permis d’obtenir un résultat conforme aux attentes pour l’un des 

conditionnements et, s’il n’y avait pas eu de problèmes techniques lors de l’usinage ni de délai dû à la 

nouveauté du logiciel de programmation des parcours d’outils, le résultat aurait certainement été tout 

aussi satisfaisant pour le deuxième. 

Je note également deux avantages intéressants des conditionnements réalisés. Premièrement, le fait 

de travailler entièrement à partir d’un modèle numérique de l’objet permet de ne jamais devoir le 

manipuler entre sa numérisation et son placement dans le conditionnement. Cela participe donc à une 

réduction des risques.  
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Deuxièmement, l’utilisation de matériaux de conservation très légers facilite la manipulation et la 

consultation des spécimens. Ce modèle de conditionnement ne conviendrait pas tel quel pour de 

grands objets lourds : il faudrait une boîte plus rigide et résistante. Il présente toutefois l’avantage de 

ne pas ajouter un important poids supplémentaire à celui de l’objet, surtout en considérant que celui-

ci n’est pas censé être sorti de son conditionnement. 

À titre personnel, ce travail de diplôme m’a permis de découvrir des outils pour lesquels j’avais depuis 

longtemps un intérêt, mais que je n’avais jamais eu l’occasion d’utiliser. J’ai également pu conduire 

pour la première fois l’entièreté d’un projet de conservation en mettant en pratique les notions 

apprises tout au long de mes études en Bachelor. La nécessité de gérer tant la logistique et le 

planning que les notions théoriques et la réalisation pratique a été très formatrice et j’ai consolidé mes 

compétences professionnelles. Quant au résultat obtenu, même s’il n’est pas terminé, j’ai pu constater 

avec plaisir que la méthodologie utilisée fonctionne bien. Par conséquent, j’ai convenu avec Jurassica 

de livrer la moitié manquante lorsque les outils seront à nouveau disponibles. 
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10 Glossaire 

Alpes dinariques : portion des Alpes « qui s’étend de la Dalmatie jusqu’aux Balkans, avec pour 

sommet principal le Dinari »52. 

Bassin (sédimentaire) : « dépression […] de la croûte terrestre d’origine tectonique, dans laquelle 

de grandes quantités de sédiments […] se sont déposées ou se déposent encore »53. 

Charbon : « roche sédimentaire combustible, riche en carbone, de couleur noire ou marron foncé, 

formée à partir de la dégradation partielle de la matière organique des végétaux »54. 

Logiciel libre : « logiciel distribué avec l’intégralité de ses programmes-sources, afin que l’ensemble 

des utilisateurs qui l’emploient puissent l’enrichir et le redistribuer à leur tour »55. 

Mandibule : os de la mâchoire inférieure56. 

Marais : « zone humide en région basse avec des eaux stagnantes où s’accumulent des sédiments 

sur une faible épaisseur. […] Un marais accueille surtout des végétaux herbacés »57. 

Marécage : zone humide qui, contrairement au marais, accueille des végétaux ligneux (arbres, 

arbustes)58. 

Miocène : division de l’échelle de temps géologique qui s’étend de -23 Ma (millions d’années) à -5,3 

Ma. À cette période, les plantes et les animaux étaient assez modernes et les mammifères ont 

proliféré. Elle est divisée en Miocène inférieur, moyen et supérieur59. 

Mousse à cellules fermées : aussi appelée mousse à alvéoles fermées, mousse dont chacune des 

cellules (ou alvéoles) est isolée dans une mince paroi de plastique, comme de petites bulles60.  

Mousse non réticulée : mousse constituée de polymères à longues chaînes (thermoplastiques), qui 

sont soufflés par des agents d’expansion alors qu’ils sont en fusion61. 

 

52 « Dinarique », 1994 [en ligne].  

53 « Bassin sédimentaire », 2021 [en ligne]. 

54 « Charbon », 2024 [en ligne].  

55 Commission d’enrichissement de la langue française, 2007 [en ligne].  

56 « Mandibule », 1994 [en ligne] 

57 « Marais », 2023 [en ligne].  

58 « Marais », 2023 [en ligne].  

59 « Miocène », 2023 [en ligne]. 

60 Tétreault, 2017, p. 49 ; « Mousse de polyéthylène », 2007 [en ligne]. 

61 Mousse de polyéthylène, 2007 [en ligne]. 
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Mousse réticulée : mousse constituée de polymères « dont les longues chaînes linéaires ont été 

reliées entre elles par des liaisons transversales de manière à former une structure tridimensionnelle » 

irréversible, par procédé chimique ou par irradiation62. 

.ncp (format) : format de fichier propriétaire de l’entreprise Isel, constitué de données de parcours 

d’outils utilisées pour contrôler une machine CNC63. 

Paléoenvironnement : « ensemble des caractères physico-chimiques et biologiques des milieux du 

passé »64. 

Précision : « qualité qui définit l’erreur relative ou l’erreur absolue dans la mesure d’une grandeur »65. 

Résolution : « plus petite valeur absolue pouvant être distinguée ou identifiée par un système de 

mesure ou un dispositif quelconque »66. 

Roche sédimentaire : « roche formée par l’accumulation de sédiments, un dépôt de matière dû à 

l’action de l’eau ou de l’air »67. 

Stratigraphie : « Branche de la géologie s’intéressant à la succession et à l’âge des couches 

géologiques »68  

.stl (format) : format de « fichier constitué de données qui permettent de représenter un modèle 

3D »69. 

  

 

62 Mousse réticulée, 2024 [en ligne]. 

63 « KAY », 2024 [en ligne]. 

64 Foucault, 1980 [en ligne].  

65 « Précision », 1994 [en ligne]. 

66 « Résolution », 1994 [en ligne]. 

67 « Roche sédimentaire », 2021 [en ligne].  

68 Organisation météorologique mondiale, 2012 [en ligne].  

69 « Fichier STL », 2023 [en ligne]. 
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11 Annexes 

11.1 Matériaux et fournisseurs 

Tableau 4 Produits utilisés pour la fabrication du conditionnement 

Produit Fournisseur Prix (CHF) Livraison (CHF) Remarque 

Ethafoam® 220 

épaisseur 30 mm 

Vibraplast AG 

www.vibraplast.ch 

info@vibraplast.ch  

+41 52 368 00 50 

32.00/m2 ? Les blocs de mousse utilisés 

pour ce travail se trouvaient 

déjà à Jurassica. 

Polypropylène 

cannelé 

épaisseur 3,8 mm 

1800 x 2500 mm 

Oekopack 

Conservus AG 

www.oekopack.ch  

info@oecag.ch  

+41 33 655 90 55 

42.50/pce 120.00  

Rivets 

Ø 4 x 12 mm 

Hornbach 

www.hornbach.ch 

0.09/pce -  

Fermetures pour 

caisse 

Hornbach 

www.hornbach.ch  

2.35/pce -  

 

  

http://www.vibraplast.ch/
mailto:info@vibraplast.ch
http://www.oekopack.ch/
mailto:info@oecag.ch
http://www.hornbach.ch/
http://www.hornbach.ch/
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11.2 Procédure pour la modélisation des conditionnements en 

mousse dans Blender 

N.B. La version en anglais du logiciel est utilisée, car c’est celle qu’on retrouve le plus dans les 

différents tutoriels ou aides en ligne, en cas de problème. 

Réglages de départ 

1. Ouvrir un nouveau fichier Blender. 

2. Supprimer les éléments présents dans l’environnement (lumières, objets, etc.). 

3. Faire les réglages suivants dans le volet de droite (propriétés) : 

- Scene  > Units > Unit system > Metric 

- Scene  > Units > Unit scale > 0.001 

- Render  > Color management > View transform > Raw 

- Output  > Format > Resolution > Utiliser les mêmes valeurs pour X et Y (par exemple 

2500 px) 

- Output  > Output > File format > OpenEXR 

- Output  > Output > Color depth > Float (Full) 

Créer les heightmaps de l’objet 

1. Importer le modèle 3D de l’objet (File > Import). 

2. Orienter le modèle de l’objet le long des trois axes selon la position voulue dans le 

conditionnement. Puis appuyer sur Ctrl + A pour ouvrir le menu « apply » et sélectionner « all 

transforms ». 

3. Passer de  à  (en haut à gauche) et faire les manipulations suivantes : 

- Select > all (pour sélectionner l’ensemble de l’objet) 

- Alt + S (pour utiliser l’outil « shrink/fatten ») 

- Taper au clavier la valeur de grossissement voulue en mm (par exemple 0.4) 

4. Revenir en  et passer en vue « material preview »  (en haut à droite) 

5. Se positionner en vue orthographique depuis le dessus par rapport à l’objet. 

  

6. Dans le volet du bas, en mode « shader editor » , cliquer sur  pour ajouter 

une texture à l’objet. 

7. Supprimer le node « principled BSDF » qui est apparu, mais conserver le node « material 

output ». Ajouter les nodes suivants :  
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- Input > Geometry 

- Converter > Separate XYZ 

- Converter > Math > Multiply 

- Converter > Math > Greater Than 

8. Relier les nodes ainsi :

Régler la valeur de 

seuil de « Greater than » sur 1. 

10. Changer progressivement la valeur de « Multiply » jusqu’à obtenir la plus grande valeur pour 

laquelle l’objet apparaît entièrement noir (sans taches de blanc). 

11. Supprimer le node « Greater than » et relier directement « Multiply » à « Material output » : 

 

12. Ajouter une caméra à la scène : Add > Camera. 

13. Sélectionner la caméra. Dans ses propriétés , choisir Lens > Type > Orthographic. Puis 

changer la valeur « orthographic scale » jusqu’à ce que la caméra recouvre tout l’objet. 

14. Si la caméra se situe plus bas que le sommet de l’objet, changer sa position sur l’axe Z dans 

Object  > Transform > Location > Z. 

15. Cliquer sur Render > Render image (en haut à gauche). Une nouvelle fenêtre s’ouvre, avec 

l’image capturée par la caméra (il s’agit de la heightmap de l’objet). Sauvegarder cette image 

(Image > Save) et fermer cette fenêtre. 

16. Pour créer une heightmap de l’autre côté de l’objet, appliquer à celui-ci une rotation de 180° 

selon l’axe Y dans Object  > Transform > Rotation > Y. Puis, refaire les étapes 8 à 15. 

Créer une empreinte dans un plan 

1. Ajouter un plan à la scène : Add > Mesh > Plane. 

2. Changer la taille de ce plan dans Object  > Transform > Scale, jusqu’à obtenir un carré de 

la même taille que le champ de la caméra. 

3. En ayant le plan sélectionné, cliquer sur Modifiers  > Add modifier > Deform > Displace. 

4. Cliquer sur New, puis sur  pour passer à la sélection de la texture. 
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5. Dans l’onglet texture qui s’ouvre alors, cliquer sur Open et sélectionner l’image sauvegardée 

précédemment. 

6. La forme de l’objet n’apparaît pas immédiatement dans le plan. Pour cela, passer à nouveau 

en  et subdiviser le plan : clic droit sur le plan > Subdivide. 

7. Dans le petit volet « Subdivide » qui apparaît, entrer le nombre de coupes à faire pour 

subdiviser le plan dans « Number of cuts ». Le maximum qui peut être entré en une fois est 

100. Pour un objet très détaillé, cela peut ne pas être suffisant. Si c’est le cas, repasser en 

 puis en  et faire une nouvelle subdivision (par exemple, 10 coupes 

supplémentaires). 

8. Revenir en . L’empreinte de l’objet devrait être visible dans le plan. Régler la force 

du déplacement dans Modifiers  > Displace > Strength, pour arriver à une empreinte de 

même hauteur que la moitié de l’objet qui doit s’y insérer. 

9. Pour vérifier que l’empreinte correspond bien à l’objet, on peut utiliser la vue Wireframe  

(en haut à droite). 

10. Lorsque les dimensions de l’empreinte sont bonnes, dans Modifiers  > Displace, cliquer sur 

 puis « apply » pour valider définitivement la modification du plan. 

Imprimer l’empreinte dans un bloc 

1. Ajouter un cube à la scène : Add > Mesh > Cube 

2. Modifier les dimensions du cube dans Object  > Transform > Scale, pour obtenir les 

dimensions du support voulu. Par défaut, le cube créé mesure 2 x 2 x 2 mm. Donc, entrer les 

dimensions divisées par 2, en mm, dans Scale, pour multiplier les dimensions de ce cube et 

obtenir la taille voulue. 

3. Pour ajouter des « créneaux » au bloc de mousse : 

a. Ajouter un cube à la scène. 

b. Modifier les dimensions de ce cube pour obtenir la taille voulue. 

c. Copier et coller ce cube le nombre de fois nécessaire plus placer tous les créneaux à 

leur emplacement sur le bloc principal. 

d. Ajouter une nouvelle collection aux éléments de la scène (clic droit > New collection) 

et placer tous ces petits cubes dedans. 

e. Sélectionner le cube principal (celui qui représente le bloc de mousse). 

f. Cliquer sur Modifiers  > Add modifier > Generate > Boolean. Sélectionner 

« Union ». Dans « Operand type », sélectionner « Collection » et dans « Collection » 

sélectionner la nouvelle collection qui vient d’être créée. 

g.  Cliquer sur  puis « apply » pour valider définitivement la modification du cube. 
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4. Placer le plan qui contient l’empreinte de l’objet sur le « cube » qui représente le support en 

mousse. Le plan doit être placé de façon à ce que l’empreinte de l’objet soit à l’endroit où on 

veut que le support soit creusé dans la réalité.  

Attention : il ne faut pas superposer de manière exacte la surface du plan et la surface du 

cube, mais laisser un léger décalage (par exemple, de 0,001 mm).  

5. Sélectionner le cube. Cliquer sur Modifiers  > Add modifier > Generate > Boolean. 

Sélectionner « Difference » puis, en cliquant dans , sélectionner le 

plan qui contient l’empreinte de l’objet. 

6. Par cette opération de soustraction, le cube contient désormais l’empreinte de l’objet. Cliquer 

sur  puis « apply » pour valider définitivement la modification du cube. Le modèle du 

support est terminé. 

7. Copier et coller ce modèle dans un nouveau fichier Blender qui ne contient aucun autre 

élément. Cliquer sur File > Export > STL et sauvegarder le modèle. 

Raccourcis clavier utiles 

- Ctrl + Alt + Q pour afficher plusieurs vues orthographiques en même temps (selon les 

différents axes) 

- G pour attraper (« grab ») un objet sélectionné et le déplacer librement. Taper X, Y ou Z après 

G permet de le déplacer selon un seul axe de manière très précise avec les flèches du clavier. 

 


